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Setting up and Preparing for
an Event

Setting

If you want to...

set up Event Center for Windows

make sure your systemcan handle Universal
Communications Format (UCF) media files

get prepared for an event

up Event Center

See...

Setting up Event Center for Windows

Checking your systemfor UCF Compatibility

Preparing for an event (on page 3)

To participate in an event, you must set up Event Center on your computer.
Once you schedule, start, or join an event for the first time, your event service
Web site starts the setup process. However, to save time, you can set up the
application at any time before scheduling, starting, or joining an event.

If you want to...

get an overview of system requirements

set up Event Center for Windows

check your systemfor UCF compatibility

See...

Systemrequirements for Event Center for
Window s

Setting up Event Center for Windows

Checking your systemfor UCF Compatibility
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System requirements for Event Center for Windows

You can find the system requirements and other information about compatible
browsers and operating systems on the User Guides page for your service:

1 Log in to your WebEx Event Center site.

2 On the WebEx Event Center navigation bar, click Support > User
Guides.

3 On the right side of the page, under Release Notes and FAQs, click the
link for release notes.

Setting up Event Center for Windows

Before installing Event Center, ensure that your computer meets the minimum
system requirements. For details, see System requirements for Event Center
for Windows (on page 2).

If you are not using the Windows operating system, please refer to our FAQ,
which includes information about setting up Event Center on other operating
systems.

To go to the list of FAQs:

1 On your Event Center Web site, on the left navigation bar, click Support >
User Guides.

2 Onthe User Guides page, under Release Notes and FAQs, click the link
for FAQs (Frequently Asked Questions).

A list of questions displays, arranged by topic. Look for your information
about your operating system under Minimum System Requirements.

To set up Event Center for Windows:

1 On the navigation bar, expand Set Up, and then click Event Manager.
The Set Up page appears.

2 Click Set Up.

3 If a security dialog box appears, click Yes.

Setup continues. A progress message box appears, indicating the
progress of setup.

4 On the Setup Complete page, click OK.
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You can now start, schedule, or join an event.

Note:

= Alternatively, you can download the Event Manager for Windows Installer from the
Support page on your Event Center Web site, and then install Event Manager on
your Web browser. This option is useful if your system does not allow you to install
Event Manager directly from the Set Up page.

= If you or another attendee plans to share Universal Communications Format (UCF)
media files during an event, you can verify that the required components are
installed on your system to play the media files. For details, see Checking your
system for UCF Compatibility (on page 3).

Preparing for an event

To take advantage of the many features available in an event, check your
system and then install some tools to extend event capabilities.

= Check your system for UCF compatibility (if you have presentations with
animations, save them as .ucf so event attendees can view these effects)
More... (on page 3)

= Set up and install Cisco WebEx Connect More... (on page 4)

= Share a remote computer, if this feature is available More... (on page 4)

Checking your system for UCF Compatibility

If you intend to play or view Universal Communications Format (UCF) media
files during the event, either as a presenter or an attendee, you can verify that
the following components are installed on your computer:

= Flash Player, for playing a Flash movie or interactive Flash files
= Windows Media Player for playing audio or video files

Checking your system is useful if you or another presenter plans to share a
UCF multimedia presentation or standalone UCF media files.

To check your system for UCF compatibility:
1 On the navigation bar, do one of the following:

= If you are a new event service user, click New User?.
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= If you are already an event service user, expand Set Up, then click
Event Manager.

2 Click Verify your rich media players.

3 Click the links to verify that the required players are installed on your
computer.

Note: The option to check your system for required rich media players is available only if
your Event Center Web site includes the UCF option.

About WebEx Connect

Use WebEx Connect, the instant messenger for business users to send
secure instant messages, invite or remind participants, and manage an event.
Connect integrates with Microsoft Outlook corporate directories and
calendars, encrypts messages and scans them for viruses, and offers quick
access to business conferencing services from WebEX.

To download WebEx Connect:

1 Log in to your Event Center Web site.

2 On the Event Center navigation bar, click Support > Downloads.

3 Scroll down to the section of the page describing WebEx Connect.

4 Click the link to learn more about this product and download it.

About sharing a remote computer

Use remote computer sharing to show all event participants a remote
computer. Depending on how you set up the remote computer, you can show
the entire desktop or just specific applications. Use remote computer sharing
to show attendees an application or file that is available only on a remote
computer.

Attendees can view your remote computer, including all your mouse
move ments, in a sharing window on their screens.

You can share a remote computer during an event for which you are the
presenter, if:

= You have installed the Access Anywhere Agent on the remote computer
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* You logged in to your Event Center Web site before joining the event, if
you are not the original event host

For information about setting up a computer so you can access it remotely,
refer to the Access Anywhere User's Guide.






Planning an Event

Planning is essential to delivering a successful online event. By taking the
time to specify the details of an event, you can make your event as effective
and engaging as possible for your attendees.

The Schedule an Event page on your Event Center Web site offers a variety
of features that let you specify details for an online event according to your
needs.

To access the Schedule an Event page:
1 Log in to your Event Center Web site.

2 On the left navigation bar, click Host an Event > Schedule an Event.

Getting started

These tasks can help you get started in planning your event:
= Define your roles. For details, see Defining your roles (on page 8).

= Determine whether to host a listed or an unlisted event. For details, see
Specifying whether the event is listed or unlisted (on page 10).

= Determine registration options for attendees. For details, see Specifying
registration options for attendees (on page 10).

= Create invitation lists for attendees and panelists. For details, see Inviting
participants to your event (on page 22).

= Use the automated email management system to send out invitations,
reminder, and other follow-up communications. For details, see Sending
email messages to participants (on page 31).
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Set up audio options for the event. For details, see Selecting audio
conference options (on page 42).

Play a presentation while attendees wait for you to join the event. For
details, see Sharing a presentation or document automatically (on page
50).

Adding security for your event

When you are scheduling or running an event, you can provide security for
the event by doing any of the following:

Require a password—If you specify a password, attendees must provide
this password to join the event.

Make the event "unlisted"—When scheduling an event, you can specify
the event as unlisted. An unlisted event is not displayed on the List of
Events page on your Event Center Web site. Attendees obtain complete
information about the event from your invitation email message.

Require attendees to provide their registration IDs—For either a listed
or an unlisted event, you can request registration and require attendees to
provide their registration IDs before joining the event. If you specify this
option, each attendee receives a unique registration ID after you approve
his or her registration request. For more information, see Requiring a
registration ID for joining an event (on page 11).

Restrict access to the event—Once all attendees have joined an event,
you can prevent additional attendees from joining it by restricting access to
the event. For details, see Restricting access to an event (on page 189).

Tip: Choose a lewvel of security based on the event's purpose. For example, if you
schedule an event to discuss your company pichic, you probably need to specify only a
password for the event. Howewer, if you schedule an event in which you will discuss
sensitive financial data, you may want to make the event unlisted.

Defining your roles

Your event production team can be broken down into the following roles:
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Role

Description

host

the participant w ho schedules, starts, manages, and ends the event
and designates the presenter, panelists, and polling coordinator

The event host initially is the presenter. After the invited panelists join
the event, the host can pass the presenter control to any of the
panelists at any time during the event.

presenter

the participant, with the presenter control sy mbol @ ,who is
responsible for sharing and presenting information during the event.

panelist

a participant w ho is primarily responsible for assisting the presenter
and participating in presentation. For more information, see About

panelist roles and privileges (on page 187).

polling coordinator

the participant, with the ol symbol, w ho is responsible for preparing a
poll questionnaire and conducting a poll during the event.

attendee

a participant w ho mainly listens or w atches and does not present
information during the event

The following figure shows an example of the different roles in an event.

| = | Participants: 5

e
(1]

) Mame £ Tools
(=) Panelists: 3
Felicia Wu (Host)
& John Smith
Mary Lou ul

= Attendees: 2

(0 displayed)
Wiewy all aftendees...

Tips for assigning responsibilities

Create a document or storyboard that defines how you plan to produce the

event.
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Example. The document or storyboard can include the information for host,
presenter, and panelist assignments, such as who will start and end the
presentation, present slides, demonstrate software, handle the Q & A session,
act as the poll coordinator, reply to chat messages, and so on.

Specifying whether the event is listed or unlisted

When scheduling an event, you can specify how the event is displayed on
your Event Center Web site:

= Listed—The event appears on the List of Events page for anyone who
visits your Event Center Web site. A listed event may or may not require
registration.

= Unlisted—The event does not appear on the List of Events page on your
Event Center Web site. Attendees receive an invitation email message
that includes complete instructions about joining the event. An unlisted
event may or may not require registration.

To make an event listed or unlisted:

On the Schedule an Event page, under Basic Information, select one of the
following:

= Listed
=  Unlisted

Specifying registration options for attendees

10

When scheduling an event, you can:

= Request attendees to register More... (on page 11)

= Require a registration ID for joining the event More... (on page 11)
= Requiring a registration password More... (on page 12)

= Setting approval rules for event registrants More... (on page 12)

= Customize the registration form More... (on page 13)

= Specify a destination Web page after registration More... (on page 22)
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Requesting attendees to register

Whether your event is listed or unlisted, you can request attendees to register
for your event.

Attendees receive an invitation email message that includes information about
the event, including the registration password, if you specify one, and a link
that they can click to register for the event.

To request registration for an event:

On the Schedule an Event page, select Required at Registration.

Requiring a registration ID for joining an event

You can add security to your event by requiring that attendees provide their
registration IDs to join the event.

Attendees receive an invitation email message that includes a link that they
can click to register for the event. Once you approve an attendee’s
registration request, the attendee receives a unique registration ID in a
confirmation email message.

To require a registration ID for joining an event:

1 Onthe Schedule an Event page, at Registration, select Required.

2 In the Attendees & Registration section, select Yes at Registration ID
required.

11
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Requiring a registration password

Specify a registration password only if you want to limit attendance to those
whom you invite to register. The attendees that you invite receive an invitation
email message, which contains the registration password and a link they can
click to register for the event.

To specify a registration password for an event:
1 On the Schedule an Event page, at Registration, select Required.

2 In the Attendees & Registration section, select Yes at Registration
password, and specify a password in the text box.

Setting approval rules for registrants

12

If you require approval for registration requests, you can set up approval rules
to automatically approve or reject registrants using logical strings (For
example, you can require that an attendee’s company name must contain the
word WebEX.).

To set approval rules for registrants:

1 On the Schedule an Event page, go to the Attendees & Registration
section.

2 At Approval required, select Yes.
3 Click Set up approval rules.
The Approval Rules window appears.

4 See the following figure to learn how to set up rules.

{'D Select a parameter fromthis drop-dow n list.

@ Select a logical string in this drop-dow n list.
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@ Type the word or words that youw ant to include in the approval rule.

{-D Select an action in this drop-dow n list.

@ To match the case of the text provided by a registrant to that of the text in @ select
Match case.

5 When you finish setting up a rule, click Add Rule.
The approval rule appears in the Rules list.

6 When you finish adding rules, click Save.

Customizing the registration form

You can customize the registration form by adding or changing the questions.
A registration form contains these two types of questions:

= Standard Questions—Selecting the check box under the " option
indicates that it is an optional question on the registration form. Selecting
the check box under the ® option indicates that it is a required question on
the registration form.

= My Custom Questions—You can add text boxes, check boxes, option
buttons, and drop-down lists to the registration form and customize the
guestions.

After you add a customized option to the registration form, you can edit it
at any time. You can also reorganize the questions by using the up and
down arrows.

To customize a registration form:

1 On the Schedule an Event page, go to the Attendees & Registration
section, and then click the link at Registration form.

The Customize Registration Questions page appears.
2 Under Standard Options, do the following:
= For each option that you want to appear on the registration form, select
the check box under *" .
= For each option for which you want to require attendees to provide

information, select the check box under _3

13
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3 Under My Custom Questions, add any of these types of questions:
= Text Box.
For details, see About the Add Text Box window (on page 15).
= Check Boxes.
For details, see About the Add Check Boxes window (on page 17).
= Option Buttons.
For details, see About the Add Option Buttons window. (on page 18)
= Drop-Down List.
For details, see About the Add Drop-Down List window (on page 19).

4 To select questions you have previously saved, click My Registration
Questions.

For details, see About the Add From My Registration Questions/Survey
Questions window (on page 21).

5 Optional. To reorganize your questions, click the up and down arrows in
the Change Order column.

Change Order

-
- v

il

6 When you finish adding customized questions, click Save.

7 Click Close in the window that appears.

Displaying lead scores and company names on the Attendee List

During the event, you can have the Attendee List display these two types of
information next to the name of each attendee:

= the attendee's response to the "Company" question on the registration
form

= the attendee's total lead score based on his or her responses to the
guestions on the registration form
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You can sort the Attendee List
based on the scores or search
for a company name and gain a
better understanding of w hich
attendees should be given
priority during the event.

Important: If you want to display lead scores and company names on the Attendee List,
you must do these two things on the registration form:

= Use the lead scoring option in the Add Check Boxes, Add Option Buttons, or Add
Drop-Down List windows.

= Specify that the "Company" and all questions with assigned scores are required
information—that is, select the symbol &

For more information, see Customizing the registration form (on page 13) and About lead
scores (on page 20).

About the Add Text Box window

How to access this window

If you are creating or editing a post-event survey, do the following:

1 On the Schedule an Event or Edit Event page, go to the Event Description
& Options section.

2 Do one of the following:

= |If this is the first time you create a post-event survey on your Event
Center Web site, click Create post-event survey.

15
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= [f you saved surveys as templates before, click Select survey. On the
window that appears, click Create New Survey.

3 In the window that appears, click Text Box.

If you are creating or editing a registration form, do the following:

1 On the Schedule an Event or Edit Event page, go to the Attendees &
Registration section.

2 Click the link next to Registration form.

3 Inthe window that appears, click Text Box.

What you can do in this window

Specify a text question that requires attendees to type information or answers
in the text box provided on the survey or registration form.

Options in this window

Use this option ... To...

Text box label Compose atext question. A text box label can contain a
maximum of 256 characters.

Type Specify w hether the text box contains a single line or multiple
lines. If you select Multi-line, specify a number of lines in the
Height box.

Width Specify the width of the text box, in characters. The number

that you specify deter mines how wide the text box appears on
the survey or registration form but does not affect the number
of characters that an attendee can type in the text box. A text
box can contain a maximum of 256 characters.

Height Specify the number of lines that the text box contains. To
specify the number of lines, you must first select Multi-line
nextto Type. If you do not specify a number, Event Center
uses the default height, w hich is one line.

16



Chapter 2: Planning an Event

About the Add Check Boxes window

How to access this window

If you are creating or editing a post-event survey, do the following:

1 On the Schedule an Event or Edit Event page, go to the Event Description
& Options section.

2 Do one of the following:

= If this is the first time you create a post-event survey on your Event
Center Web site, click Create post-event survey.

= If you saved surveys as templates before, click Select survey. On the
window that appears, click Create New Survey.

3 Inthe window that appears, click Check Boxes.

If you are creating or editing a registration form, do the following:

1 On the Schedule an Event or Edit Event page, go to the Attendees &
Registration section.

2 Click the link next to Registration form.

3 In the window that appears, click Check Boxes.

What you can do in this window

Specify questions that allow attendees to select multiple answers or choices
on the survey or registration form. Each answer or choice appears next to a
check box.

Options in this window

Use this option ... To...

Group label for check boxes Compose a question.

Note If you are adding only one check box and
do not want a group label, leave this box blank.

17
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Use this option ... To...

Check box 1to 9 Compose the answ ers or choices, and specify w hich

check boxes are selected or cleared by default on the
survey or registration form.

To add check boxes to the form, use the Add drop-
dow n list.

Score Specify a score for each response to the question. For

more information, see About lead scores (on page 20).

About the Add Option Buttons window

18

How to access this window

If you are creating or editing a post-event survey, do the following:

1

3

On the Schedule an Event or Edit Event page, go to the Event Description
& Options section.

Do one of the following:

= [f this is the first time you create a post-event survey on your Event
Center Web site, click Create post-event survey.

= [If you saved surveys as templates before, click Select survey. On the
window that appears, click Create New Survey.

In the window that appears, click Option Buttons.

If you are creating or editing a registration form, do the following:

1

On the Schedule an Event or Edit Event page, go to the Attendees &
Registration section.

Click the link next to Registration form.

In the window that appears, click Option Buttons.

What you can do in this window

Specify questions that allow attendees to select one single answer or choice
on the survey or registration form. Each answer or choice appears next to an
option button.
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Options in this window

Use this option ... To...
Group label for option buttons Compose a question.
Default choice Specify w hich is the default answ er or choice.
Choice 1to 9 Compose the answ ers or choices.
To add option buttons, use the Add drop-
dow n list.
Score Specify a score for each response to the

guestion. For more information, see About
lead scores (on page 20).

About the Add Drop-Down List window

How to access this window

If you are creating or editing a post-event survey, do the following:

1

3

On the Schedule an Event or Edit Event page, go to the Event Description
& Options section.

Do one of the following:

= If this is the first time you create a post-event survey on your Event
Center Web site, click Create post-event survey.

= If you saved surveys as templates before, click Select survey. On the
window that appears, click Create New Survey.

In the window that appears, click Drop-Down List.

If you are creating or editing a registration form, do the following:

1

On the Schedule an Event or Edit Event page, go to the Attendees &
Registration section.

Click the link next to Registration form.

In the window that appears, click Drop-Down List.

19
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What you can do in this window

Specify questions that allow attendees to choose one single answer or choice

on the survey or registration form. Each answer or choice appears in the drop-
down list.

Options in this window

Use this option ... To...
Label for drop-down list box Compose a question.
Default choice Specify w hich is the default answ er or choice.
Choice 1to 9 Compose the answ ers or choices.
To add option buttons, use the Add drop-
dow n list.
Score Specify a score for each response to the

guestion. For more information, see About
lead scores (on page 20).

About lead scores

20

When customizing a survey or registration form, you can specify a score for
each response to a question. Your site administrator can later generate a
report that shows each attendee’s total score, so you can identify the most
qualified leads from the scores as well as the other information you have
gathered from the survey or registration form.

During the event, you can have the Attendee List display these two types of
information next to the name of each attendee:

= the attendee's response to the "Company" question on the registration
form

= the attendee's total lead score based on his or her responses to the
questions on the registration form
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You can sort the Attendee List
based on the scores or search
for a company name and gain a
better understanding of w hich
attendees should be given
priority during the event.

Important: If you want to display lead scores and company names on the Attendee List,
you must do these two things on the registration form:

= Use the lead scoring option in the Add Check Boxes, Add Option Buttons, or Add
Drop-Down List windows.

= Specify that the "Company" and all questions with assigned scores are required

information—that is, select the symbol 3

For more information, see Customizing the registration form (on page 13) and About lead
scores (on page 20).

About the Add From My Registration Questions/Survey
Questions window

How to access this window

If you are creating or editing a post-event survey, do the following:

1 On the Schedule an Event or Edit Event page, go to the Event Description
& Options section.

2 Do one of the following:

= |If this is the first time you create a post-event survey on your Event
Center Web site, click Create post-event survey.
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= [|f you saved surveys as templates before, click Select survey. On the
window that appears, click Create New Survey.

3 Inthe window that appears, click My Survey Questions.

If you are creating or editing a registration form, do the following:

1 On the Schedule an Event or Edit Event page, go to the Attendees &
Registration section.

2 Click the link next to Registration form.

3 Inthe window that appears, click My Registration Questions.

What you can do in this window

Select questions that you have previously saved, and then add them to this
survey or registration form.

Options in this window

Use this option ... To...

Check boxes Select a question, and then click Add to add
it to the current form.

Links for the questions Edit a question, and then save it.

Specifying a destination Web page after registration

You can specify a destination Web page that displays once an attendee
submits the registration form.

To specify a destination URL.:

1 On the Schedule an Event page, go to the Attendees & Registration
section.

2 At Destination URL after registration, type a URL in the text box.

Inviting participants to your event

To invite attendees and panelists to your event using the WebEx automated
email system, do the following:

22
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1 Fromthe Schedule an Event page, create invitation lists.

For details, see Creating an invitation list and inviting attendees to your
event (on page 23) or Creating an invitation list and inviting panelists to
your event (on page 28).

2 After you schedule the event, the Send Event Emails page displays
immediately.

3 Select the recipients on the page, and click Send Now.

Note: Clicking Send Later takes you to the Event Information page, on which youcan
send invitation email messages at a later time.

Creating an invitation list and inviting attendees to your event

You can select contacts from an existing address book or add new contacts
on your Event Center Web site.

If you have a large number of contacts in a distribution list, you can import the
distribution list in the CSV (comma-separated/comma-delimited values)
format.

To create an invitation list and invite attendees to your event:

1 On the Schedule an Event page, go to the Attendees & Registration
section.

2 Click Create invitation list.
3 In the window that appears, add any of the following:

= new attendees who are not already contacts in one of your address
books. For details, see Adding a new contact to your invitation list (on
page 24).

= contacts and contact groups already in your address books on the
Event Center Web site. For details, see Adding existing contacts to
your invitation list (on page 26).

= distribution list in the CSV format. For details, see Importing a
distribution list to your invitation list (on page 28).

4 When you finish specifying options on the Schedule an Event page, click
Schedule This Event.

23
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5 Onthe Send Event Emails page, select the recipients, and then click Send
Now.

Send Event Emails

You hawe successfully scheduled your event.

Send invitation emails to: [] Hast

Panelists
Attendees
] “endors

[ Send Mow... ] [ Send Later

Note: Clicking Send Later takes you to the Event Information page, on which you
can send invitation email messages at a later time.

6 Click OK and Continue on the messages that appear on your screen.

Each attendee that you invite receives an invitation email message, which
includes a link that the attendee can click to obtain more information about
the event and to join the event.

Note: Once you start the event, you can still invite more attendees. For details, see
Inviting attendees to an event in progress.

Adding a new contact to your invitation list

When scheduling an event, you can add a new contact to your invitation list—
that is, an attendee who is not already a contact in one of your address books
in My WebEXx on the Event Center Web site. Once you specify information
about a new contact, you can also add the contact to one of your address
books.
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To add a new contact to your event invitation list:

1

Tip:

If you have not already done so, click Create Invitation List on the
Schedule an Event page.

For details, see Creating an invitation list and inviting attendees to your
event (on page 23) and Creating an invitation list and inviting panelists to
your event (on page 28).

Under New Attendee or New Panelist, provide information about the
contact.

For more information about the Time zone, Language, and Locale options,
see About time zones, languages, and locales (on page 25).

Optional. To add the new contact to your Personal Contacts address book,
select the Add new attendee in my address book or Add new panelist
in my address book check box.

Optional. To add a new panelist as an alternate host, one who can start
this event and act as the host, select the Invite as alternate host check
box.

Note: An alternate hast must have an account on your site. In addition, only a
panelist can be an alternate host.

Click Add to Invitation List.
The contact displays under Attendees to Invite or Panelists to Invite.

Click Invite.

To view a list of the attendees or panelists you selected for an event, click View
invitation list in the Attendees & Registration or Presenters & Panelists section.
To delete acontact from an attendee or panelist invitation list, click Edit invitation
list in the Attendees & Registration or Presenters & Panelists section. Select the
contact, click Delete, and then click OK.

About the time zone, language, and locale options

Host only

For each attendee you plan to invite to your event, you can select a language,
time zone, and locale in which your invitation displays text, dates, and times.
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You can specify time zones, languages, and locales for an attendee when you
are:

= adding a new contact (A new contact is an attendee who is not already in
one of your address books in My WebEX.)

= editing an existing contact (The settings you specify here will replace the
contact's original settings.)

Important:

= If you customize an email template, attendees will receive customized email
messages in your language, rather than in the languages specified in attendee
settings.

= [f you do not customize an email template, attendees will receive email messages in
the languages specified in attendee settings.

= For details about customizing email messages, see About customizing email
messages (on page 35).

Adding existing contacts to your invitation list

26

When creating event invitation lists, you can select contacts in the following
lists:

= Personal Contacts—Includes any individual contacts that you have added
to your personal address book. If you use Microsoft Outlook, you can
import the personal contacts that you keep in an Outlook address book or
folder to this list of contacts.

= Company Address Book—Your organization's address book, which
includes any contacts that your site administrator has added to it. If your
organization uses a Microsoft Exchange Global Address List, your site
administrator can import its contacts to this address book.

To add an existing contact to your event invitation list:

1 If you have not already done so, click Create Invitation List on the
Schedule an Event page.

For details, see Creating an invitation list and inviting attendees to your
event (on page 23) or Creating an invitation list and inviting panelists to
your event (on page 28).

2 In the Create Attendee Invitation List window or Create Panelist Invitation
List window, click Select Contacts.
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In the View drop-down list, select one of the following contact lists:
= Personal Contacts

= Company Address Book

The contact list that you selected displays.

Select the check box for each individual contact or contact group that you
want to add to your list of attendees or panelists.

When selecting contacts, you can do the following:

= Inthe Index, click a letter of the alphabet to display a list of contacts
whose first names begin with that letter. For example, the name Susan
Jones appears under S.

= To search for a contact in the list that you are currently viewing, type
text that appears in either the contact's name or email address in the
Search for box, and then click Search.

Do either or both of the following:
= Click Add Attendees or Add Panelists.

= Optional. To add a panelist from your existing contacts as an alternate
host, select that contact and click Add as an alternate host.

Note: An alternate host must have an account on your site. In addition, only a
panelist can be an alternate host.

The contacts that you selected display under Attendees to Invite or
Panelists to Invite.

To add the selected contacts to your invitation list, click Invite.

To view a list of the attendees or panelists you selected for an event, click View
invitation list in the Attendees & Registration or Presenters & Panelists section.

To delete acontact from an attendee or panelist invitation list, click Edit invitation list
in the Attendees & Registration or Presenters & Panelists section. Select the contact,
click Delete, and then click OK.
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Importing a distribution list to your invitation list

Adding a large number of contacts to your invitation list is easy if you have
them in a distribution list in the CSV (comma-separated/comma-delimited
values) format.

To import a distribution list to your event invitation list:

1

If you have not already done so, open the Create Invitation List window
from the Schedule an Event page.

For details, see Creating an invitation list and inviting attendees to your
event (on page 23)or Creating an invitation list and inviting panelists to
your event (on page 28).

Click Import CSV Files.
Follow the instructions on your screen to upload a distribution list.

When the system finishes importing all the contacts in the list, click Close.

Creating an invitation list and inviting panelists to your event

28

You can select contacts from an existing address book or add new contacts
on your Event Center Web site.

If you have a large number of contacts in a distribution list, you can import the
distribution list in the CSV (comma-separated/comma-delimited values)
format.

To create an invitation list and invite panelists to your event:

1

2

3

On the Schedule an Event page, go to the Presenters & Panelists section.
Click Create invitation list.
In the window that appears, add any of the following:

= new attendees who are not already contacts in one of your address
books. For details, see Adding a new contact to your invitation list (on
page 24).

= contacts and contact groups already in your address books on the
Event Center Web site. For details, see Adding existing contacts to
your invitation list (on page 26).
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= distribution list in the CSV format. For details, see Importing a
distribution list to your invitation list (on page 28).

4 When you finish specifying options on the Schedule an Event page, click
Schedule This Event.

5 On the Send Event Emails page, select the recipients and then click Send
Now.

Send Event Emails

You have successfully scheduled your event.

Send invitation emails to: [] Hast

FPanelists
Attendees
1 wendors

[ Send Mow... ] [ Send Later

Note: Clicking Send Later takes you to the Event Information page, on which you
can send invitation email messages at a later time.

6 Click OK and Continue on the messages that appear on your screen.

Each panelist that you invite receives an invitation email message, which
includes a link that the panelist can click to obtain more information about
the event and to join the event.

Editing an invitation list

When scheduling or editing an event, you can edit your invitation list for both
attendees and panelists.

To edit an invitation list:

1 On the Schedule an Event or Edit Event page, go to the Attendees &
Registration section or Presenters & Panelists section, as appropriate.

29



Chapter 2: Planning an Event

2 Click Edit invitation list.

3 Click the contact's name in the Name column.

Once you click the name of the
contact, you can edit the contact
information in the Edit Attendee or
Edit Panelist section.

4  Make your changes.

5 Click Update Invitation List.
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Sending email messages to participants

If you want to ... See ...

get an overview of sending email messages | About sending email messages to
to your event participants participants (on page 31)

learn about the various email messages you | Aboutthe Email Messages section (on page
can send or customize w hen scheduling or 31)
editing an event

include iCalendar attachments in your email | Including iCalendar attachments in email
messages messages (on page 34)

About sending email messages to participants

When scheduling an event, you can choose from various types of participant
email messages, such as registration status, reminders, and follow-ups, in the
Email Messages section. The WebEx automated e mail system will send
selected email messages at times you specify. For details, see About the
Email Messages section (on page 31).

In addition, you can customize the templates by editing, rearranging, or
deleting the content and variables—code text that Event Center uses to
substitute for your specific event information. For details, see About
customizing email messages (on page 35).

About the Email Messages section

How to access this section

On the left navigation bar of your Event Center Web site, under Host an
Event, click Schedule an Event, and then go to the Email Messages
section.

What you can do in this section

Select or customize email messages that you want to send to event
participants.

31



Chapter 2: Planning an Event

To customize an email message template, click the link for that email
message. For example, click the Attendees link to customize the invitation
email message to attendees.

To select a type of email message to participants, select the appropriate
check box. For example, select the Thank You for Attending check box to
send a follow-up email message after the event ends.

Options in this section

Using this option ... You can do the following ...

Email Format Select Plain Text to send all email messages
in plain text format.

Select HTML to send all email messages w ith
the formatting you w ant, such as numbering,
bullets, bold face, and italics.

Invitation emails Click the Attendees link to customize the
invitation email message to attendees.

Click the Panelists link to customize the
invitation email message to panelists.

Note For details, see Customizing an
email message for aspecific event (on
page 37).
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Using this option ...

You can do the following ...

Registration emails

Select the check boxes to send notifications
to registrants about their registration status.

Pending—Notifies that you have received the
attendee’s registration and that it is pending
approval.

Approved—Notifies that you have accepted
the attendee’s registration. This email
message contains a link the attendee can
click to join the event.

Rejected—Notifies that you have declined
the attendee’s registration request. The
default email message does not contain a
reason for rejection, so you may w ant to
customize the message.

Event In Progress—Sends an emalil
message to the attendees you invite after you
start the event. Click this link to customize the
email message.

Note To customize the email messages
for Pending, Approved, Rejected, and
Event In Progress, click the links. For
details, see Customizing an email
message for a specific event (on page
37).

Event updated emails

Customize the email messages that are sent
to event participants about event updates.
When you update your event, you can
choose to send an event updates email to
any of the follow ing recipients (These options
appear after you click Update This Event on
the Edit Event page.):

All Approved Registrants—Sends an email
message to only those w hose registration has
been approved

All Attendees—Sends an email message to
all the attendees you invite using the WebEx
email system

All Panelists—Sends an email message to
all the panelists you invite using the WebEx
email system
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Using this option ... You can do the following ...

Reminder emails Select the check boxes to send reminders to
registrants at specific times.

1st Reminder—Sends an email message
reminding registrants to join the event.

2nd Reminder—Sends a second email
message reminding registrants to join the
event.

Note To customize the reminder email
messages, click the links. For details,
see Customizing an email message for a
specific event (on page 37).

Follow-up emails Select the check boxes to send follow -up
email messages to attendees.

Thank You for Attending—Thanks an
attendee for attending the event, and
contains information about how the attendee
can provide feedback on the event.

Absentee Follow-Up Email—Informs an
absentee that the event has occurred, and
provides the host’'s contact information. Event
Center sends this message to each registrant
who did not attend the event.

Note To customize the follow-up email
messages, click the links. For details,
see Customizing an email message for a
specific event (on page 37).

Including iCalendar attachments in email messages

To let invited participants add the scheduled event to their calendar programs,
such as Microsoft Outlook, you can include an iCalendar item in your emalil
messages, such as those for invitation, event updates, and registration
confirmation.

To include iCalendar attachments in your email messages:
1 On the Schedule an Event page, go to Email Messages.

2 Select Include iCalendar Attachments.
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Event Center includes an iCalendar attachment, in the .ics format, in your
email messages. If a participant opens the .ics file, a meeting item opens.
The participant can then save the meeting item in his or her calendar.

Customizing email messages

If you want to ... See ...

get an overview of customizing email About customizing email messages (on page
messages 35)

customize an email message for an event Customizing an email message for a specific
that you are scheduling or editing event (on page 37)

customize an email message template for Customizing an email message for future
events that you may schedule in the future events (on page 38)

About customizing email messages

Event Center provides up to three templates for each type of email message.
You can customize them on these two levels:

= event level—for a specific event that you are currently scheduling or
editing. For details, see Customizing an email message for a specific
event. (on page 37)

= host level—for all future events you will schedule. The changes you make
on this level automatically apply to any future event that you schedule on
your Event Center Web site. For details, see Customizing an emalil
message for future events (on page 38).

About the Edit Event Email/Template Name: [template name]
page

How to access this page
1 Do one of the following, as appropriate:

= On the left navigation bar of your Event Center Web site, click Host an
Event > Email Templates.
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= On the Schedule an Event or Edit Event page, go to the Email
Messages section.

2 Select an email template that you want to customize, and then click Edit.

Options on this page

Use this option ... To...
Email Template Name Enter a different name for this template if it's
necessary.

Available only if you are customizing the
template for all future events.

From name Enter the sender’s name. This name appears
in the email message that participants
receive.

From email Enter the sender’s email address. This

address appears in the email message that
participants receive. By default, Event Center
uses this variable, % SenderEmailAddress%,
which retrieves the corresponding information
fromthe mail server for your Event Center
Web site. The default email address is
messenger@webex.com.

Reply to email Enter the email address to w hich youw ant all
replies to this message to be sent. By default,
Event Center uses this variable,
%HostEmail%, w hich retrieves the
corresponding infor mation specified in your
user profile.

Note To specify a different email
address, delete the entire variable—the
text and the percentage signs together,
and then type the new email address in
the box.

Subject Enter a subject that will appear in the subject
line of the email message.

Header image Click Add to add a header image in this email
message.

Available only in HTML templates.

Footer image Click Add to add a footer image in this email
message.

Available only in HTML templates.
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Use this option ... To...

Revert to Default Revert the template to the original state,
which is set up by your site administrator.

Preview Preview the email message in the text or
HTML format that you selected.

Save Save the changes you make.

Tip: WebEx recommends that you set up an email account that you can use exclusively
for producing events. You can specify that address in the Reply to email box. For
example, you can set up an account with the address events@your_company.com.

Customizing an email message for a specific event

When you are scheduling or editing an event, you can customize an email
message template for the specific event by editing, rearranging, or deleting
the content and variables—code text that Event Center uses to substitute for
your specific user or event information.

Important: Youcan delete or rearrange variables, but never change the text in a
variable. For example, in this variable, %ParticipantName%, do not change the text
ParticipantName within the percentage signs. If you change it, Event Center cannot
substitute the correct text from your user or event information.

To customize an email message for an event:

1 On the Schedule an Event page or Edit Event page, in the Email
Messages section, click the link for the email message that you want to
customize.

For more information, see About the Email Messages section (on page
31).

2 Select a template in the Select email message drop-down list, and then
click Edit.

3 Make your changes on the Edit Event Email: [template name] page.
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For details, see About the Edit Event Email/Template Name: [template
name] page (on page 35).

4 To save the changes you make, click Save > OK.

Customizing an email message for future events

38

You can customize email message templates for all future events you will
schedule on your Event Center Web site. The changes you make on this level
automatically apply to any future event that you schedule.

You customize an email message template by editing, rearranging, or deleting
the content and variables—code text that Event Center uses to substitute for
your specific user or event information.

Important: Youcan delete or rearrange variables, but never change the text in a
variable. For example, in this variable, %ParticipantName%, do not change the text
ParticipantName within the percentage signs. If you change it, Event Center cannot
substitute the correct text from your user or event information.

To customize an email message template for future events:

1 On the left navigation bar of your Event Center Web site, click Host an
Event > Email Templates.

2 Choose the type of email message you want to edit in the For: drop-down
list, and then click one of the templates in the HT ML or plain text section,
depending on your need.

3 Click Edit.
4 Make your changes on the Template name: [te mplate name] page.

For details, see About the Edit Event Email/Template Name: [template
name] page (on page 35).

5 To save the changes you make, click Save.

Note: To revert the email message to its original, default state, click Revert to Default.
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About variables in an email template

A variable is composed of text surrounded by two percentage signs. Each
variable used in Event Center email templates is replaced in actual messages
by corresponding information specified in an attendee’s registration data, in
your user profile, on the Event Information page, and so on.

This table describes each of the variables and how you can use them.

This variable

%AttendeeNam e%

%Disclaimer%

%Dow nloadInstruction%

%Em ail Footer%

Is replaced by...

the first and last names that the attendee specified
when registering for or joining the event

This variable is replaced by the follow ing text:

IMPORTANT NOTICE: This WebEx service includes a
feature that allows audio and any documents and
other materials exchanged or view ed during the
session to be recorded. By joining this session, you
automatically consent to such recordings. If you do not
consent to the recording, do not join the session.

This variable is replaced by the follow ing instructions

for dow nloading the Event Center application:

To join the event more quickly, you can set up the
softw are that you need to join the event before it
starts. Go to the URL above, then click Set Up.

This variable is replaced by the follow ing format:

http://www webex.com
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This variable

%EnrollmentID%

%EventAddress URL %

%EventPassw ord%

%EventTimeZone%

%HostEm ail%

%HostNam e%

%HostPhone%

%Join URL %

%Join URL Str%

%MeetingDate%

Is replaced by...

the registration ID for the attendee

Event Center automatically creates this ID for an
attendee after you approve his or her registration
request. If this event does not require registration, this
variable is replaced by the follow ing text:

This event does not require a registration ID.

a hyperlink

You can use this in event descriptions.

the event passw ord that you specified w hen
scheduling the event. If you do not require a passw ord,
this variable is replaced by follow ing text:

This event does not require a passw ord.

the time zone that you specified w hen scheduling the
event

the email address that you specified in your user
profile

the first and last names that you specified in your user
profile

the phone number that you specified in your user
profile

a hyperlink

You can use this in instructions for joining the event.

a URL that doesn't contain a hyperlink
You can use this in instructions for joining the event.

Example. You can use the variable in this way: To
join the event, <a href="% Join URL Str%">click
here.</a>

the date that you specified w hen scheduling the event
in the follow ing format:

Day, Month DD, YYYY—for example: Friday, April 12,
2009



This variable

%MeetingInfoURL %

%MeetingTime%

%PanelistNam e%

%ParticipantName%

%RegistrationPassw ord%

%SenderEmailAddress %

%Teleconferencelnfo%

%Topic%

%UCFAttendeeVerifyPlayers %
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Is replaced by...

the URL for the Event Information page for the event

Event Center automatically creates the URL once you
schedule an event.

the time that you specified w hen scheduling the event
in the follow ing format:

HH:MM [am /pm]—for example: 12:30 pm

the panelist’s first and last names that you specified
when scheduling the event

the first and last names that the participant specified
when either registering for or joining the event

the passw ord you specified for attendees to register
for the event

the email address specified on the email server for
your Event Center Web site.

The default address is: messenger@w ebex.com

This variable is replaced by the follow ing text:

To join the teleconference, call % CallinNumber% and
enter the meeting number.

The variable %CalllnNumber% is replaced by the
numbers that you specified w hen scheduling the
event.

the event name that you specified w hen scheduling
the event

If UCF is turned on for this event, and you select
Request Attendees to verify rich media players
when scheduling the event, the follow ing displays:

The playback of UCF (Universal Communications
Format) rich media files requires appropriate players.
To view this type of rich media files in the event,
please check w hether you have the players installed
on your computer by going to [URL].
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Selecting audio conference options

To provide audio during an event, choose from these audio options on the
Schedule an Event or Edit Event page:
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Audio options

WebEx
Teleconferencing
Service

Descriptions

An integrated teleconference.

Enter the number of callers that you expect to join the teleconference in
the Estimated number of callers box. If you expect more than 125
callers for the teleconference, please contact your WebEx account
manager to increase your audio conference capacity.

Select one of these types of WebEx teleconferences:

Attendees call in—Attendees call a phone number to join the
teleconference and assume the charges for their calls.

Attendees receive a call back—Attendees provide their phone
numbers once they join the event, and then receive call-backs at the
phone numbers they provide. You or your organization assumes the
charges for the calls. Recorded instructions guide the attendee
through the process of connecting to the teleconference.

For more information, see Setting up a teleconference for an event (on
page 46).

Whether you select Attendees call in or Attendees receive a call
back, you can select any of these options:

Allow access to teleconference via global call-in numbers—
Allow s attendees in different countries to call in using Web Ex
international call-in numbers. A list of numbers—such as toll-free or
local numbers—appears on attendees’ screens once they join the

event.

For a list of toll-free calling restrictions by country, go to
www w ebex.convpdf/tollfree_restrictions.pdf.

The phone number displays in a message box on attendees’
screens once they join the event. When an attendee calls the phone
number, recorded instructions guide the attendee through the
process of entering a teleconference in the event.

Broadcast audio stream to all attendees—Provides one-w ay
audio streamfrom a teleconference to attendees’ computers. Rather
than connecting to a teleconference, attendees can listen to the
audio portion of the event through their speakers or headsets. For
more information, see Broadcasting audio streams to all attendees
(on page 220).

Mute upon entry for all participants—Mutes participants’

telephones once they join the WebEx teleconference. Panelists can
unmute their ow n phones. How ever, attendees need the host to

unmute their phones.



Audio options

Other teleconference
service
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Descriptions

A teleconference that a third-party service provides. Enter in the text box
instructions for joining a teleconference. The instructions display in a
message box on attendees’ screens once they join the event. For more
information, see Setting up a teleconference for an event (on page 46).

When you use a third-party service provider, you can select this option:

Broadcast audio stream to all attendees—Provides one-w ay audio
stream from a teleconference to attendees’ computers. Rather than
connecting to a teleconference, attendees can listen to the audio portion
of the event through their speakers or headsets. For more information,
see Using a third-party teleconference for audio broadcast (on page
222).

Note If more than 500 participants will attend your event, you can use
either a third-party teleconferencing service or the WebEx Operator-
Assisted Audio Conference Services. To learn more about the WebEx
Operator-Assisted Audio Conference Services, contact your WebEx
account manager.
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Audio options

Cisco Unified
MeetingPlace Audio

Conferencing

Integrated VolP

No Teleconference

Descriptions

An integrated audio conference. If you select this option, choose the type
of conference:

= Attendees call in: Select if you want customers to dial a number to
join

= Attendees receive call back: Select if youw ant customers to type
in a phone number and receive a call back fromthe conferencing
service.

A participant must have a direct phone line to receive a call fromthe
conferencing service. How ever, a participant w ithout a direct phone line
can join an audio conference by dialing a call-in number, w hich is alw ays
available in the meeting window .

Whichever option you choose, you can select any of these options:

= Broadcast audio stream to all attendees—Provides one-w ay
audio streamfrom a teleconference to attendees’ computers. Rather
than connecting to a teleconference, attendees can listen to the
audio portion of the event through their speakers or headsets. For
more information, see Broadcasting audio streams to all attendees
(on page 220).

=  Mute uponentry for all participants—Mutes participants’
telephones once they join the WebEx teleconference. Panelists can
unmute their ow n phones. How ever, attendees need the host to
unmute their phones.

A voice conference in w hich participants use computers w ith audio
capability to communicate over the Internet rather than the telephone
system. Integrated VolP can be either half-duplex, w hich lets only one
attendee speak at a time, or full-duplex, w hich allows up to two

participants to speak at the same time.

For more information, see Setting up an Integrated VolP conference for
an event (on page 48).

No teleconference is available in the event.

To provide audio in the event, select Integrated VolP.

Setting up a teleconference for an event

46

Teleconferencing options may differ, depending on which options your

organization uses.

To set up a teleconference:

1 On the Schedule an Event or Edit Event page, go to Teleconference.
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Select one of the following options:

WebEx Teleconference Service.

For the WebEXx teleconference service, select one of the following:
[0 Attendees call in

[0 Attendees receive a call back

Enter the number of estimated callers in the Estimated number of
callers box.

Cisco Unified MeetingPlace Audio Conferencing.

For Cisco Unified MeetingPlace audio conferencing, select one of the
following:

0 Attendees call in
[0 Attendees receive a call back

Other teleconference service—The event includes a teleconference
that another service provides. Enter in the text box instructions for
joining the teleconference. The instructions display in a message box
once an attendee joins the event.

If you want to allow attendees in different countries to call in using WebEXx
international call-in numbers, select Allow access to teleconference via
global call-in numbers.

If you want to provide one-way audio to attendees without requiring them
to join your teleconference, select Broadcast audio stream to all
attendees.

If you want to mute all participants’ telephones once they join the event,
select Mute upon entry for all participants.

Click Schedule This Event or Update.

Note: Once you schedule the event, instructions for joining the teleconference display in
the Join Teleconference dialog box once participants join the event.
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Setting up an Integrated VolP conference for an event

You can set up Integrated VolIP in addition to or as an alternative to a
teleconference.

To set up an Integrated VolIP conference:

1 Onthe Schedule an Event or Edit Event page, go to Teleconference.
2 Select the Integrated VolP check box.

3 Click ScheduleThis Event or Update This Event.

Note:

= [f you set up an Integrated VolIP conference, you must start the conference
before the other participants can start using it in the event.

= Only participants whose computers meet the system requirements for
Integrated VolIP can participate in the conference.

= If you use WebEx Recorder to record the event and want to capture audio in
the recording, ensure that the correct audio compression scheme is selected.
For details, refer to the WebEx Recorder and Player User's Guide, which is
available on the User Guides page on your Event Center Web site.

System requirements for Integrated VolIP

To participate in an Integrated VolIP conference, you must ensure that your
computer meets the following system requirements:

= asupported sound card

For a list of supported sound cards, refer to the Frequently Asked
Questions page on your Event Center Web site. You can access this page
from your site's Support page.

= speakers or headphones

= microphone, if you want to speak during the conference

Tip: For better audio quality and greater convenience, use a computer headset with a
high-quality microphone.

48



Chapter 2: Planning an Event

Setting up a dual-mode voice conference

You can set up a dual-mode voice conference for an event—that is, an audio
conference that includes both a teleconference and an Integrated VolP
conference. In a dual-mode voice conference, participants can use either type
of conference.

In a dual-mode voice conference, a participant can listen to audio using either
a phone or speakers attached to his or her computer. To speak, a participant
can use either a phone or microphone attached to his or her computer.

For details about setting up a teleconference and Integrated VolP conference,
see:

= Setting up a teleconference for an event (on page 46)

= Setting up an Integrated VolP conference for an event (on page 48)

Playing alerts when participants join or leave a
teleconference
When scheduling an event, you can specify the type of tone that plays in all

participants' phones once a participant joins or leaves the teleconference.
This option is applicable only if you use integrated teleconference.

To specify sound alerts:

1 On the Schedule an Event or Edit Event page, go to Additional Event
Options.

2 Inthe Entry and exit tone drop-down list, choose one of the following
options:

= Beep—A simple tone plays once a participant either joins or leaves the
teleconference.

= Announce name—uUpon joining the teleconference, a participant must
record his or her name, which is then played in the teleconference. The
participant’s name is also played if he or she leaves the
teleconference.

= No tone—No alert plays in participants' phones once a participant
joins or leaves the teleconference.

49



Chapter 2: Planning an Event

Sharing a presentation or document
automatically

50

When scheduling an event, you can set up a Universal Communications
Format (UCF) presentation that plays automatically for the participants while
they wait for the event to start.

You can specify one of the following:

= A UCF presentation plays automatically in the content viewer once a
participant joins the event. If the presentation contains multiple pages, you
can also specify that it automatically advances its pages at a specified
interval.

= A Web page appears once a participant joins the event. Participants can
then browse Web pages while they wait for you to start the event.

Important:

The presentation or document that you select must:
= Be inthe Universal Communications Format (UCF).

= Reside in your personal folders inthe My WebEx area on your Event Center Web
site. You can select a UCF file that already resides in your folders or upload a new
file to your folders when scheduling an event.

To automatically share a file once an attendee joins an event:
1 On the Schedule an Event, go to Event Description & Options.
2 At UCF autoplay options, do one of the following:

= In the text box, type the Web address or URL that you want to share
automatically.

= Locate and upload a UCF file by clicking Add and doing the following
on the Add/Select Presentation page:

1 If the file resides in your personal folders on the Event Center Web
site, select the file.
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I If the file does not yet reside in your personal folders on the Event
Center Web site, click Browse, select the file, and then click
Upload. Then select the file.

[0 Click Done.
For details, see About the Add/Select Presentation page (on page 52).

If you specify to show a UCF presentation, not a Web page, do one of the
following:

= To specify that the presentation starts automatically when a participant
joins, select Start automatically.

= To allow attendees to control viewing of the presentation, select Allow
attendees to control file.

4 Optional. To specify that the presentation plays continuously during auto
play, select Continuous play.

5 Inthe Advance page every drop-down list, select the length of
intermittence in seconds between each slide.

Important:

If you share a UCF multimedia presentation that includes rich media files, such as audio
or video files, do the following:

Ensure that each media file is embedded in the presentation file or resides on a
publicly accessible Web server. If the presentation contains a link to a media file
that resides on your computer, participants cannot view that media file. For more
information about creating UCF multimedia presentations, refer to the guide Getting
Started with WebEx Universal Communications Toolkit by going to Support > User
Guides on the left navigation bar of your Event Center Web site.

Ensure that each media file is set to play automatically for participants. For more
information about setting this option for a UCF media file, refer tothe guide Getting
Started with WebEx Universal Communications Toolkit by going to Support > User
Guides on the left navigation bar of your Event Center Web site.

Select Allow attendees to control file on the Schedule an Event page. If you do
not select this option, the pages or slides in the document or presentation will
advance automatically, which may prevent some participants from viewing the
media files.
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About the Add/Select Presentation page

What you can do on this page

= Select a file already in your personal folders on the Event Center Web site
to play automatically while participants wait for the event to start.

= Upload a new file to your personal folders on the Event Center Web site to
play automatically while participants wait for the event to start.

Options on this page

Option Description
File name box Type the name of the file to upload to your folder.
Browse button Click to select a UCF presentation or document that resides in your

personal folders.

Upload button Click to upload the specified file to your folder.

Select radio button Select the button for the file to be added to the event.

Nam e Indicates the names of the files residing in your folder.
Description Describes the folder or file.

Size Indicates the size of the folder or file in kilobytes.

Done button Click to add the specified file to your event and to have it play

automatically w hile participants w ait for the event to start.

Specifying basic information

If you want to ... See ...

specify the event type and topic Specifying an event type and topic (on page
53)

automatically delete the event after it ends Automatically deleting an event after it ends
(on page 53)
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If you want to ...

See ...

copy event information from a pre-defined
template to the Schedule an Event page

Using an event template during scheduling
(on page 54)

create or edit an event template

Creating or editing an event template (on
page 55)

specify an event passw ord

Specifying an event password (on page 56)

assign the event for a program

Assigning your event to a program (on page
56)

specify a tracking code

Specifying tracking codes for a scheduled
event (on page 57)

reduce the netw ork bandw idth consumption
for joining the event

Reducing network bandwidth usage (on page
57)

Specifying an event type and topic

When scheduling an event, you must specify the event type and topic.

To specify an event type and topic:

1 Onthe Schedule an Event or Edit Event page, choose an event type in the

Event type drop-down list.

2 Type a topic for the event in the Event name text box.

Note:

= Your site administrator sets up the event type, which specifies what features are
available during an event. If your site administrator specifies more than one event
type, you must choose one in the drop-down list.

= An event topic cannot contain any of these characters: \ " "/ & <>=]

Automatically deleting an event after it ends

When scheduling an event, you can specify to automatically delete the event
from My Meetings in My WebEX after the event ends.
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Examples.

= You select the Delete from My Meetings when completed option,
schedule the event for 10 a.m. to 11 a.m., and then start and end the
event. The event will be removed from My Meetings in My WebEx at 11:01
a.m. or at the time you end the event, whichever comes later.

* You leave the Delete from My Meetings when completed check box
cleared and schedule the event. Then you start and end the event. The
event is always listed in My Meetings in My WebEXx.

Note: Whether or not you select the Delete from My Meetings when completed option,
you can always run reports from My WebEx to view information about your events. For
more information, see Generating reports (on page 430).

Using an event template during scheduling

Event templates allow event hosts to shorten scheduling time and store their
favorite settings. The Event template drop-down list lists the following
templates:

= My templates—created by yourself and displayed only if you log in to your
Event Center Web site.

= Standard templates—created by your site administrator and made
available for the event hosts in your organization.

= System template—set up by your WebEXx service; the name of the system
template is displayed in brackets in the drop-down list.
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If you choose to use a template, the information in the template, including the
event name, description, password, teleconference options, registration
options, customized registration questions, and email templates, is
automatically copied to the Schedule an Event page. You can edit the
information or options before scheduling the event.

Note: The participant list, panelist information, and registrant data are not copied to the
Schedule an Event page.

To choose an event template:

On the Schedule an Event page or Edit Event page, in the Event template
drop-down list, choose a template.

Creating or editing an event template

You can create or edit a template from the Schedule an Event page. The
templates you create or edit on this page will be included under My templates
in the Event template drop-down list.

Note: Only the site administrator can edit or create the Standard templates. Howewer,
you can save a Standard template as a new template under My templates.

To create an event template:
1 Do one of the following as appropriate:
= Specify the options on the Schedule an Event.
= Choose atemplate in the Event template drop-down list.
2 Click Save as template on the bottom of the Schedule an Event page.

3 In the window that appears, type the name of the new template in the
Template name text box.

4 Click Save.

To edit an existing event template:

1 Inthe Event template drop-down list, choose the template that you want
to edit.
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Note: Youcan modify only the templates under My templates. Only the site
administrator can edit the Standard templates.

Make your changes to the options in the template.
Click Save as template on the bottom of the Schedule an Event page.

The Template name text box displays the name of the template you
chose.

Click Save.

Click OK in the confirmation message box.

Specifying an event password

While scheduling an event, you can set a password that participants must
provide to access or view information about the event.

To set an event password:

1

2

On the Schedule an Event or Edit Event page, go to Basic Information.

Type a password in the Event password box.

Note: An event password cannot contain space or double quotation marks (“”).

Type the password again in the Confirm password box.

Assigning your event to a program

56

If you want to add your event to a program on your Event Center Web site,
you can do so when scheduling the event. Attendees can register for all the
events in a program at one time.

To add an event to a program:

1

2

On the Schedule an Event or Edit Event page, go to Basic Information.
Choose a program in the Program drop-down list.

A dialog box appears asking you to confirm adding this event to the
program you just chose.

Click OK to add the event to the program list.
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This event is grouped with the program you selected and can be viewed
on the List of Events by Program page on your Event Center Web site.

To create a new program, click Add a new Program. For details, see
Creating a program (on page 91).

Specifying tracking codes for a scheduled event

Your site administrator can specify that the tracking code options appear on
the Schedule an Event page. Tracking codes can identify your department,
project, or other information that your organization wants to associate with
your events. Tracking codes can be optional or required, depending on how
your site administrator sets them up.

To specify tracking codes for a scheduled event:

1 On the Schedule an Event or Edit Event page, go to Tracking codes, and
then select a code label in the box.

2 Do one of the following:
= [f a list of codes appear in the box, select a code from the list.

= Type a code in the appropriate box.

Tip: If your site administrator has also specified that the same tracking code options
appear in your user profile, you can edit your user profile to specify the tracking codes.
The codes then appear automatically on the Schedule an Event page.

Reducing network bandwidth usage

By selecting the option Optimize bandwidth usage for attendees within the
same network, you can help reduce the network bandwidth consumption for
joining the WebEXx event.

Example. If you are expecting a large number of attendees, and many of
them come from the same network with limited bandwidth, you may want to
select the option.

Note:
= The option works only if attendees join from computers running on Windows 2000,
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Windows Server 2003, Windows XP, and Windows Vista.

= Your site administrator detemines which hosts have the privilege of reducing
bandwidth usage for their attendees.

To reduce the network bandwidth consumption for joining your event:
1 Onthe Schedule an Event or Edit Event page, go to Basic Information.

2 At Optimize bandwidth usage for attendees within the same network,
select Yes.

Specifying date and time options

If you want to ... See ...

get an overview of specifying the event time, | About specifying the event time, duration, and

duration, and time zones time zones (on page 58)

specify the event time, duration, and time Specifying the event time, duration, and time
zones zones (on page 59)

allow attendees to join the event before it Allowing attendees to join the event and
starts teleconference early (on page 62)

send an email reminder to the host before the | Sending an email reminder to the host before
event the event (on page 63)

About specifying the event time, duration, and time zones

You can specify the time at which you want to start the event, the estimated

event duration, and the time zones in which you want to view the event. The
estimated duration gives participants an idea as to how much time they need
to reserve from their own schedules.

Note:

= The estimated duration is for your planning purposes only. An event does not end
automatically after the estimated duration that you specify.

= If you invite attendees to an event, their invitation email messages specify the
event's starting time in the time zones that you specified. However, if attendees
reside in a different time zone, they can choose to view the starting time in their time
zones from the List of Events page on your Event Center Web site.
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Specifying the event time, duration, and time zones

When setting up and scheduling an event, you must specify the event time,
duration, and time zone.

1 On the Schedule an Event or Edit Event page, go to Date & Time.
2 Do the following:

= Nextto Start date, in the drop-down lists, specify the month, day, and
year at which you want to start the event.

= Next to Start time, in the drop-down lists, specify the time at which you
want to start the event.

= Nextto Estimated duration, in the drop-down lists, specify the event
duration in hours and minutes.

= Nextto Time zones, in the drop-down list, choose a time zone in
which you want to view the event. To specify more time zones, click
Display more time zones.

Planning and selecting event time zones

If your event participants are located in different geographical regions, Event
Center makes it easy for you to select a suitable time across up to four time
zones.

Click Plan event
time zones to
select a suitable
time for your
participants in
different time zone.
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The time zones you
select will display
on the scheduling
page and, later, in
invitation email
messages.

To select time zones and a suitable starting time:

1 On the Schedule an Event or Edit Event page and at the Start time
option, click Plan event time zones.

2 Add or select time zones.

This is the time zone your site administrator has designated for
@ your Event Center Web site. To change it, do so atthe Time

zones option on the Schedule an Event or Edit Event page .

@ To add time zones, click t]

@ Use the drop-dow n list to select a time zone.

3 Optional. To save the time zones you selected here for future use, select
Save participants time zones.

4 Click Show Time.
5 Select the most suitable time across the time zones you have selected.

6 Click Select Time.
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About time zones in invitation email messages

Your invitation email messages include all the time zones, including the base
time zone (your own time zone) you have selected when scheduling an event.

The time zones you have selected in
the scheduling page display in
invitation email messages. The first
time zone is your base time zone.

If an attendee has a desighated time
zone in the contact information, the
designated time zone will replace
your base time zone in the

attendee's invitation email message.

Example. You have specified these
time zones: San Francisco (base
time zone), Taipei, Honolulu, and
London. Attendee Johnson has
"New York" in his setting. Johnson
w ill see this list of time zones in his
invitation email message:

= New York
= Taipei
= Honolulu

. London

Note:

Attendees who have user accounts can designate time zones, languages, and
locales in their profiles on the Event Center Web site. For more information, see
About maintaining your user profile (on page 418).

If those attendees are already contacts in your address book on the site, you can add themto
your event invitation list. Their language and time zone preferences will then display in their
invitation email messages. For more information, see Adding existing contacts to your
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invitation list (on page 26).

For attendees who are not yet contacts in your address book or do not have any pre-
defined preferences on the Event Center Web site, you can designate a time zone,
language, and locale for each of them when scheduling an event. For more
information, see Adding a new contact to your invitation list (on page 24).

You can change any attendees' information, including changing the time zone,
language, or locale information, by editing the invitation list. For more information,
see Editing an invitation list (on page 29).

Allowing attendees to join the event and teleconference early

62

When scheduling an event, you can choose to allow attendees to join the
event and WebEXx teleconference before the scheduled starting time. If
attendees join an event before the starting time, you receive an emalil
message hotifying you that an attendee or panelist has joined your event.

Tip: Youcan set up a presentation to inform or entertain the participants while they wait
for the event to start. For details, see Sharing a presentation or document automatically
(on page 50).

To allow attendees to join the event and WebEx teleconference early:

1

2

On the Schedule an Event or Edit Event page, go to Date & Time.

Select the check box for Attendees can join X minutes before the
scheduled start time, and then specify how early they can join the event.

Optional. To allow attendees to join the WebEXx teleconference once they
join the event, select the check box for Attendees can also connect to
WebEXx teleconference.

Note: Youcan set up a presentationto inform or entertain the participants
while they wait for the event to start. For details, see Sharing a presentation
or document automatically (on page 50).

Click Schedule This Event or Update.
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Sending an email reminder to the host before the event

You can send an email reminder to yourself, as the host, before the start of

the event.

To send an email reminder to the host:

1 On the Schedule an Event or Edit Scheduled Event page, go to Date &

Time.

2 In the drop-down list next to Email reminder, choose how early you want
the email to be sent before the event starts.

If you do not want an email sent, select None in the drop-down list.

Specifying event descriptions and options

If you want to ...

See ...

specify an event description

Specifying an event description (on page 64)

format an event description in HTML

Formatting an event description (on page 64)

upload an image that attendees can view
fromthe Event Information page

Adding an image to an event description (on
page 64)

let participants dow nload and cache files
before the event starts

Providing event material before an event (on
page 65)

specify a destination Web page (URL) that
attendees see after the event has ended

Specifying a destination URL after an event
(on page 67)

prevent attendees from sharing rich media
files in the event

Preventing event attendees from sharing rich
media files (on page 67)

request participants to verify that rich media
players are installed on their computers

Requesting participants to check their rich
media players (on page 68)

specify w hich participants can view the
attendee list

Specifying whether to display attendee list to
all participants (on page 68)

include video in your event

Selecting video options (on page 69)

add a post-event survey

Adding a post-event survey (on page 69)
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Specifying an event description

You can specify a description of the event, which attendees can view from the
Event Information page before they join the event.

To specify a description of the event:

1 Onthe Schedule an Event or Edit Event page, go to Event Description &
Options.

2 Inthe Description text box, type a description of the event.

To format the description in HT ML code, see Formatting an event
description (on page 64).

Formatting an event description

You can format an event description using HT ML (Hypertext Markup
Language) code. The description can include links to Web pages or images
that reside on a publicly accessible Web server on the Internet, such as the
server on which your organization’s Web site resides.

If you use a Web page authoring program, you can create a formatted event
description using that program and then copy its HT ML code and paste it in
the Description box.

Tip: After you format an event description and finish scheduling the event, you can verify
whether it appears correctly on the Event Information page.

Adding an image to an event description
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You can add a picture to an event description. The picture appears on the
Event Information page, which attendees can view before the event starts.

The picture that you add must be a file that meets the following requirements:
= the GIF or JPEG format
= approximately 75 x 38pixels

= |ess than 100 KB in size



Chapter 2: Planning an Event

To add a picture to an event description:

1 On the Schedule an Event or Edit Event page, go to Event Description &
Options.

2 Next to Host image, click the link.

The Upload Your Picture window appears.

Upload Your Picture
Please click the Browse... button to select a
picture from your computer. Submission
requirements: GIF or JPG format, approx. 75 2 38
pixels, less than 100k,
Enter file name here :

Browse.

| pload | Cancel |

3 Click Browse.
4  Select the file that you want to add to your event description.
5 Click Upload.

Event Center imports your picture and adds it to the Event Information
page for the event.

To replace a picture that you added to an event description:
Upload a different picture.

Event Center overwrites the original picture with the new one.

Providing event material before an event

When scheduling an event, you can add Universal Communications Format
(UCF) files to the Event Information page, from which attendees can
download and cache the files on their own computers before the event starts.
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Providing event material ahead of time especially benefits attendees with a
slower Internet connection because caching files can significantly reduce the
loading time during an event.

Note: Before you can add event material to the Event Information page, you must first
upload them to your personal folders in the My WebEx section of your Event Center Web
site. For more information, see Maintaining files in your personal folders (on page 381).

To add event material to the Event Information page:

1

On the Schedule an Event or Edit Event page, go to Event Description &
Options, and then next to Event material, click the link for uploading
event material.

The page that appears displays the files or folders stored in your personal
folders in the My WebEX section of your Event Center Web site. For
details, see About the Add Event Material page (on page 66).

If you have not uploaded the files to your personal folders, click Browse to
select the file, and then click Upload.

You can upload one file at a time.

Select the radio button next to the folder that contains the files you want to
add to the Event Information page.

The files in the selected folder appear.

Select the check boxes for the files you want to add to the Event
Information page, and then click Add.

The files you have added appear in the Event material section.

Optional. Type descriptions of the files in the Description text boxes.

About the Add Event Material page

66

What you can do on this page

Select files already in your personal folders on the Event Center Web site
to publish to the Event Information page.

Upload new files to your personal folders on the Event Center Web site
and then publish them to the Event Information page.
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Attendees can download event material for review before the event starts.

Options on this page

Option

Description

File name box

Type the name of the file to upload to your folder.

Browse button

Click to select a UCF presentation or document that resides in your
personal folders.

Upload button

Click to upload the specified file to your folder.

Select

Select the check box for the file to be added to the event.

Nam e

Indicates the names of the files residing in your folder.

Description

Describes the folder or file.

Size

Indicates the size of the folder or file in kilobytes.

Add button

Click to publish the specified file on the Event Information page on
your Event Center Web site, making it available to attendees prior to
the event starting time.

Specifying a destination URL after an event

When scheduling an event, you can specify a destination Web page or Web
site that displays once the event ends.

To specify a destination URL:

1 On the Schedule an Event or Edit Event page, go to Event Description &

Options.

2 Type a destination Web site address (URL) in the Destination URL after

event box.

Preventing event attendees from sharing rich media files

Event Center, by default, allows attendees to share Universal
Communications Format (UCF) files in an event. When scheduling an event,
you can specify to turn off this function for the event.
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To prevent attendees from sharing rich media files in the event:

1 On the Schedule an Event page, go to Event Description & Options >
Other UCF options.

2 Select Do not allow attendees to share rich media files for this event,
and then click Schedule This Event.

Requesting participants to check their rich media players

If you plan to show Universal Communications Format (UCF) multimedia
presentations in the event, you can request participants to verify that rich
media players are installed on their computers before they join the event. The
invitation email messages to invited participants contain this request.

To request participants to verify their media players:

1 On the Schedule an Event page, go to Event Description & Options >
Other UCF options.

2 Select Request attendees to verify rich media players, and then click
Schedule This Event.

Specifying whether to display attendee list to all participants
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When scheduling an event, you can specify which event participants can view
the entire list of attendees during the event.

To specify who can view the attendee list:

1 On the Schedule an Event or Edit Scheduled Event page, go to Event
Description & Options.

2 Nextto Attendee list viewing, select one of the following:

= All—Allows each event attendee to view a list of all attendees during
the event.

= Host, presenter, and panelists only—Allows only the event host,
presenter, and panelists to view the entire list of attendees. Besides
their own names, attendees can view only the names of the host,
presenter, and panelists in the participant list.

Tip: Each time an attendee joins or leaves an event, the attendee list gets updated.
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Thus, for events with a large number of attendees, selecting Host, presenter, and
panelists only can greatly improve the performance of the Event Center application for
attendees during an event.

Selecting video options

You can choose to make video available during the event. Only the host and
panelists can send and receive video. Attendees can only view video that is
being sent.

Note: The video feature will only be available if it has been turned on by your site
administrator.

To select video options:

1

On the Schedule an Event or Edit Event page, go to Event Description &
Options.

In the Video section, select Turn on video to make video available during
the event.

Select View high-quality video if would like high-quality video to be
available during the event.

Video can be as high as 360p resolution (640x360). However, the quality
of the video that participants can send and receive depends on each
participant's webcam and computer capability, and network speed.

Select View thumbnails if would like display thumbnail views of those
sending video.

Click Schedule This Event or Update.

Adding a post-event survey

When creating a survey, you can do the following:

add text, multiple-answer, and single-answer questions

add images
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= save the survey as a template for future use

The survey that you add will display on attendees’ screens once the event
ends.

To view survey results, you can generate an Event Center attendance report,
attendee history report, or event recording report from the My WebEx Reports
page in My WebEX. For details, see Generating reports (on page 430).

To create a post-event survey and add it to an event:

1 On the Schedule an Event or Edit Scheduled Event page, go to Event
Description & Options.

2 Do one of the following:

= If this is the first time you create a post-event survey on your Event
Center Web site, click Create post-event survey.

= If you saved surveys as templates before, click Select survey. On the
window that appears, click Create New Survey.

3 Type a survey topic and introductory text.
4 Optional. Click Add to add a header or footer image.

For detailed instructions, see About the Upload or Select Image window
(on page 71).

5 To add survey questions, click Text Box, Check Boxes, Option Buttons,
Drop-Down List, or My Survey Questions.

For detailed instructions, see About the Add Text Box window (on page
15), About the Add Check Boxes window (on page 17), About the Add
Option Buttons window (on page 18), and About the Add Drop-Down List
window (on page 19).

6 Do one of the following:
= To save the survey for this event, click Save.

= To save the survey as a template for future use and also save it for this
event, click Save As Template. Provide a template name for this
survey or save it to an existing template, and then click Save.

7 Click OK - Use This Survey.

8 On the Schedule an Event or Edit Scheduled Event page and in the Post-
event survey section, select one of these:

= Display survey in pop-up window—Specifies that this survey will
display in a separate window
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= Display surveyin main browser window (instead of destination
URL)—Specifies that this survey will display in the main window

Note: If you select Display survey in main browser window (instead of destination
URL) and also specify a destination URL that displays after the event, the destination
page will not display after the event.

About the Upload or Select Image window

How to access this window

If you are creating or editing a post-event survey, do the following:

In the Create Survey or Edit Survey: [survey topic] window, click Add next to
Header image or Footer image.

If you are editing an email te mplate, do the following:

In the Edit Event Email: [te mplate name] window, click Add next to Header
image or Footer image.

What you can do in this window

You can upload or select an image for the selected survey or email template.

Options in this window

Use this option ... TO ...

Upload a new image to your image library. Fromthe
[ Upload MNew Image... image library, you can add images to the selected
survey or email template.

Add an image to the selected survey or email template.
Add . .
Ensure to select an image before you click Add.

m Remove an image fromthe image library.
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Specifying other options for attendees

If you want to ...

See ...

invite attendees to an event

Inviting participants to your event (on page
22)

allow registrants to invite friends to the event

Allowing registrants to invite friends (on page
72)

specify a maximum number of registrations
for the event

Specifying a maximum number of registrants
(on page 72)

Allowing registrants to invite friends

When scheduling an event, you can specify that registrants can invite their

friends to your event.

To allow registrants to invite friends:

1 On the Schedule an Event or Edit Event page, go to Attendees &

Registration.

2 Select the check box next to Invite friends.

Specifying a maximum number of registrants

72

When scheduling an event, you can specify a maximum number of people

who can register for your event. When the maximum number of registrants is
reached, the last registrant receives a message that the maximum number of

registrants has been met.

To specify a maximum number of registrants:

1 On the Schedule an Event page or Edit Event page, go to Attendees &

Registration.

2 Type a number in the Maximum number of registrants box.
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Specifying options for presenters & panelists

If you want to ...

See ...

invite panelists to an event

Creating an invitation list and inviting
panelists to your event (on page 28)

allow panelists to upload files to your Event
Information page

Allowing panelists to upload documents (on
page 73)

Allowing panelists to upload documents

When scheduling an event, you can specify that panelists can provide you
with documents or presentations by uploading them from the Panelist
Entrance page. The files uploaded by panelists appear on your Event
Information page and your personal folders on your Event Center Web site.
You can then download or organize the files before you start the event.

To allow panelists to upload documents:

1 On the Schedule an Event or Edit Event page, go to Presenters &

Panelists.

2 Select the check box for Allow panelists to upload documents

associated with the event.

Viewing or accessing the files uploaded by panelists

Before starting the event, you can view, download, or organize the files

uploaded by panelists.

To view or access the files uploaded by panelists:

1 Log in to your Event Center Web site.

2 Go to either of the following pages:

= the My WebEXx Files page by going to My WebEx > My Files >

Folders

= the Event files section on the Event Information page
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Scheduling, Editing,
Canceling, and Starting an
Event

To schedule, start, edit, or cancel your events, you must have a host account
on your Event Center Web site.

If you want to ... See ...

schedule an event Scheduling an event (on page 75)

start an event Starting an event (on page 76)

edit a scheduled event Editing a scheduled event (on page 77)
cancel a scheduled event Canceling a scheduled event (on page 79)

Scheduling an event

The Schedule an Event page on your Event Center Web site lets you plan
and schedule an online event according to your needs.

For more information about specifying event details on the Schedule an Event
page, see Planning an Event (on page 7).

To schedule an event:
1 Log in to your Event Center Web site.

2 On the navigation bar, click Host an Event > Schedule an Event.
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The Schedule an Event page appears.

3 Planning the event on the page, such as creating invitation lists,
customizing the registration form, creating a post-event survey, and so on.
For details, see Planning an Event on page 9.

4 Once you finish specifying all the details on the Schedule an Event page,
click Schedule This Event.

5 On the Send Event Emails page, select the recipients of the invitation
email message, and then click Send Now.

Note: Clicking Send Later takes you to the Event Information page, on whcih you
can send event updates email messages at a later time.

6 Click OK and Continue on the messages that appear on your screen.

The Event Information page appears. You also receive a confirmation email
message that includes information about the scheduled event.

Note: The Event Information page displays the event addresses for attendees and
panelists respectively. You cancopy and paste the URLs inyour own invitation email
messages if you do not plan to use the WebEx automated email system.

Starting an event

76

If you want to ... See ...

get an overview of starting an event About starting an event (on page 77)

start an event fromyour My WebEx page Starting an event from My WebEx (on page
77)
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About starting an event

Events do not start automatically at scheduled times. Unless you specify that
attendees can join before the host, you must first start an event before
attendees can join it. For more information, see Allowing attendees to join the
event and teleconference early (on page 62).

Once you schedule an event, you receive a confirmation e mail message that
includes a link that you can click to start the event. You can also start the
event from My WebEx on your Event Center Web site.

Starting an event from My WebEx

Editing

You can start your event from the My WebEXx page on your Event Center Web
site.

To start an event from the My WebEx page:

1 Log in to your Event Center Web site.

2 Click My WebEx > My Meetings.
The My WebEx Meetings page appears.

3 Find the event that you want to start, and then click Start.
The Event window appears.

If the event includes an integrated teleconference, the Join
Teleconference dialog box appears. Follow the instructions in the dialog
box to start the teleconference.

a scheduled event

If you want to... See...

get an overview of modifying a scheduled About editing a scheduled event (on page
event 78)

modify a scheduled event fromyour My Editing a scheduled event from My WebEx
WebEx page (on page 78)
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About editing a scheduled event

Once you schedule an event, you can edit it at any time before you start it,
including its starting time, topic, password, agenda, invitation lists, and many
other options.

If you update any information about an event, including adding or removing

attendees, you can choose to send attendees a new invitation email message

that informs them that you have modified information about the event.
Attendees whom you removed from the attendee list receive an email

message informing them that the event was cancelled.

You can edit an event from the confirmation email message that you received
after you scheduled the event, or from My WebEx on your Event Center Web
site.

Editing a scheduled event from My WebEx

78

You can edit a scheduled event from My WebEXx on your Event Center Web
site and send event updates email messages to participants.

To edit a scheduled event from My WebEXx:

1

2

Log in to your Event Center Web site.

Click My WebEx > My Meetings.

The My WebEXx Meetings page appears.

In the Topic column, click the topic for the event.
The Event Information page appears.

Click Edit Event.

The Edit Event page appears.

Make your changes.

For details about the options on this page, see Planning an Event (on
page 7).

To apply your changes to the event, click Update This Event.

On the Send Event Emails page, select the recipients of the event updates
email message. If you added participants to your invitation list, you can
also send them invitation email messages with the latest event information
from this page.
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8 Click Send Now, and then click OK and Continue on the messages that

appear on your screen.

Note: Clicking Send Later takes you to the Event Information page, on which youcan
send event updates email messages at a later time.

Canceling a scheduled event

If you want to ...

See ...

get an overview of canceling a scheduled
event

About canceling a scheduled event (on page
79)

cancel a scheduled event

Canceling a scheduled event (on page 79)

About canceling a scheduled event

You can cancel an event that you scheduled at any time. As you are
canceling an event, you have the option of sending automatic cancellation
email messages to the event participants.

Canceling a scheduled event

Cancel a scheduled event from My WebEx on your Event Center Web site.

To cancel an event you scheduled:

1 Log in to your Event Center Web site.
2 Click My WebEx > My Meetings.

The My WebEx Meetings page appears.

3 Inthe Topic column, find the event you want to cancel, select the check
box next to it, and then click Delete.

4  Click OK in the message boxto confirm that you want to delete the event.
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A message box appears, allowing you to send email messages about this
cancellation.

Do one of the following, as appropriate:

= If you want to notify all invited participants, including attendees and
panelists, click Yes.

You also will receive a confirmation email message about this
cancellation.

= If you do not want to send a cancellation email message, click No.

= |f you do not want to cancel this event, click Cancel.



Scheduling a MeetingPlace
Personal Conference

meeting

If you want to...

Get an overview of MeetingPlace
Personal Conference meetings

Set up a MeetingPlace Personal
Conference meeting

Add a MeetingPlace Personal
Conference meeting to your
calendar

Make changes to the
MeetingPlace Personal
Conference meeting you have
scheduled

Start your MeetingPlace Personal
Conference meeting

Cancel your MeetingPlace
Personal Conference meeting

See...

About MeetingPlace Personal Conference meetings (on
page 82)

Setting up a Personal Conference meeting or
MeetingPlace Personal Conference meeting (on page
82)

Adding a scheduled Personal Conference meeting or
MeetingPlace Personal Conference meeting to your

calendar program (on page 83)

Editing a Personal Conference meeting or MeetingPlace
Personal Conference meeting (on page 84)

Starting a MeetingPlace Personal Conference meeting
(on page 87)

Canceling a Personal Conference Meeting or
MeetingPlace Personal Conference meeting (on page

87)
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About MeetingPlace Personal Conference
meetings

A MeetingPlace Personal Conference meeting uses your Cisco Unified
Meeting Place audio conferencing account for the audio conference, and does
not have an online portion for the meeting. MeetingPlace Personal
Conference meetings are only available if your site supports Cisco Unified
Meeting Place audio conferencing and MeetingPlace Personal Conferencing.

Setting up a Personal Conference meeting or MeetingPlace
Personal Conference meeting

To set up a Personal Conference meeting or MeetingPlace Personal
Conference meeting:
1 Log in to your Event Center website.
2 On the left navigation bar, select Schedule an Event.
3 Select Advanced Scheduler.
The Advanced Scheduler displays.

4 Onthe Required Information page, for Meeting type, select Personal
Conference or MeetingPlace Personal Conference.

5 Enter the requested information.

Note: If you are scheduling a Personal Conference meeting, you do not need to
specify a password. By default, the password is the attendee access code inyour
Personal Conference number account that is specified for this meeting. If you are
scheduling a MeetingPlace Personal Conference, you do need to specify a
password

For an overview of this page and the information requested, select the
Help button in the upper-right corner of the page.
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6 Schedule your event now, or add more details.
= To schedule your event with these details, select Schedule Event

= To add more options, select Next or select another page in the
scheduler. After you have added the details you need, select
Schedule Event.

Adding a scheduled Personal Conference meeting or
MeetingPlace Personal Conference meeting to your calendar

program

Once you schedule a Personal Conference meeting or MeetingPlace
Personal Conference meeting, you can add the Personal Conference meeting
or MeetingPlace Personal Conference meeting to your calendar program,
such as Microsoft Outlook. This option is applicable only if your calendar
program supports the iCalendar standard, a common format for exchanging
calendaring and scheduling information across the Internet.

To add a scheduled Personal Conference meeting or MeetingPlace Personal
Conference meeting to your calendar

1 Choose either method:

= On the Personal Conference Meeting Scheduled page or the Personal
Conference Meeting Information page, select Add to My Calendar.

= In the confirmation email message that you receive once you schedule
or edit a Personal Conference meeting or MeetingPlace Personal
Conference meeting, click the link to add the meeting to your calendar.

A meeting opens in your calendar program.
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2 Select the option to accept the meeting request. For example, in Outlook,
select Accept to add the Personal Conference event item to your
calendar.

Note:

= [f you cancel aPersona Conference meeting or MeetingPlace Personal Conference
meeting, the Personal Conference Meeting Deleted confirmation page and the
confirmation email message that you receive contains an option that lets you remove
the meeting from your calendar program.

= If you invte participants to a Personal Conference meeting or MeetingPlace
Personal Conference meeting, the invitation email message that they receive also
contains an option to add the meeting to their calendar programs.

Editing a Personal Conference meeting or MeetingPlace
Personal Conference meeting
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Once you a schedule a Personal Conference meeting or Meeting Place
Personal Conference meeting, you can make changes to it at any time before
you start it—including its starting time, topic, agenda, attendee list, and so on.

If you update any information about the Personal Conference meeting or
MeetingPlace Personal Conference meeting, including adding or removing
attendees, you can choose to send attendees a new invitation email message
containing the new details about the meeting. Attendees removed from the
attendee list receive an email message letting them know that they are no
longer asked to attend.

If you are logged in, you can edit the meeting details by clicking the link in the
confirmation email message that you received after you scheduled the
Personal Conference meeting or MeetingPlace Personal Conference meeting,
or from your list of events in My WebEXx.

To edit Personal Conference meeting or MeetingPlace Personal Conference
meeting from the confirmation email message:

1 Open your confirmation email message, and then c